
1

Leawo Free Blu-ray Player for Mac User

Guide

Product: https://www.leawo.org/blu-ray-player-mac/

Download: https://www.leawo.org/downloads/blu-ray-player-mac.html

User guide: https://www.leawo.org/blu-ray-player-mac/user-guide.html

https://www.leawo.org/blu-ray-player-mac/?pdf
https://www.leawo.org/downloads/blu-ray-player-mac.html?pdf
https://www.leawo.org/blu-ray-player-mac/user-guide.html?pdf


2

Content
Leawo Free Blu-ray Player for Mac User Guide.................................................................................. 1

Introduce Leawo Free Blu-ray Player for Mac.............................................................................3
1. Introduce the main interface.......................................................................................... 4
2. Introduce playback interface.......................................................................................... 4
3. Introduce Leawo Free Blu-ray Player for Mac Program Menu.......................................6

3.1 Leawo Blu-ray Player.............................................................................................7
3.2 File......................................................................................................................... 7
3.3 Playback.................................................................................................................8
3.4 BD/DVD to MKV.................................................................................................... 8
3.5 Window................................................................................................................. 9
3.6 Help....................................................................................................................... 9

How to Purchase and Activate Leawo Blu-ray Player Premium?............................................. 10
1. How to purchase Leawo Blu-ray Player Premium for Mac...........................................10
2. How to activate Leawo Blu-ray Player Premium for Mac.............................................10

Leawo Free Blu-ray Player for Mac Preferences Settings......................................................... 12
1. General settings............................................................................................................ 12
2. Video settings................................................................................................................12
3. Audio settings................................................................................................................13
4. DVD/Blu-ray settings.....................................................................................................14
5. Subtitles settings........................................................................................................... 15
6. Hotkeys settings............................................................................................................ 16
7. File Associations settings.............................................................................................. 17

How to Play Blu-ray/DVD/Video/Audio/ISO Files with Leawo Free Blu-ray Player for Mac.... 19
Step 1: Load source media files........................................................................................ 19
Step 2: Set subtitles (optional)..........................................................................................20
Step 3: Video settings (optional).......................................................................................21
Step 4: Audio settings (optional)...................................................................................... 21

Rip and Convert Blu-ray/DVD to MKV on Mac without Quality Loss.......................................22
Step 1: Import Source Blu-ray/DVD files...........................................................................22
Step 2: Choose titles to convert........................................................................................23
Step 3: Set converting directory........................................................................................24
Step 4: Start converting Blu-ray/DVD to MKV.................................................................. 25



3

Introduce Leawo Free Blu-ray Player for Mac

Leawo Blu-ray Player for Mac includes 2 versions: Free Blu-ray Player and Blu-ray Player Premium.

Leawo Free Blu-ray Player for Mac comprises of region-free Blu-ray player (including 4K UHD
Blu-ray), free DVD player, free ISO player, free HD video player (including 4K and 1080P), free ISO

image file player, and free audio player. As a multifunctional Mac media player, Leawo Free
Blu-ray Player for Mac could play up to 4K UHD Blu-ray, DVD, ISO file, audio, and up to 4K HD

video on Mac without quality loss.

This region free Blu-ray player for Mac could remove disc protection and region code restriction,

so as to play Blu-ray disc with AACS, BD+, and the latest MKB protection, and CSS-DVD discs.
With support of various advanced audio decoding technologies, this Mac Blu-ray media player

could play back Dolby, DTS, AAC, TrueHD, DTS-HD and other high quality audios. During movie
playback, Leawo Blu-ray Player for Mac allows users to set subtitles, audio tracks and videos for

better movie experience. Various playback control operations are included, like full-screen
display, playlist, external subtitle loading, etc.

Compared to Leawo Free Blu-ray Player, Leawo Blu-ray Player Premium could decrypt, rip and
convert Blu-ray/DVD movies to quality-lossless MKV files on Mac. The Premium version has all

the basic features Free version has.
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1. Introduce the main interface

After launching Leawo Free Blu-ray Player for Mac, on the main interface, click the big green

"Open File" button to browse and load video, audio and ISO image file

from your local drive for playing. Once you insert a video disc into the disc recorder drive, you

could see a disc loading icon like this to load disc directly from disc
drive.

2. Introduce playback interface

Once you have imported source video or disc files, you will come to the playback interface. When
you move mouse to the movie title area on the playback interface, you could see several icons

listed on the top-left:

: Click to open the subtitle setting panel of playing media files.

: Click to open the video setting panel of playing media files.

: Click to open the audio setting panel of playing media file.

: Click to open menu setting panel of playing Blu-ray/DVD files.

At the bottom of the playback interface, you could see multiple playback control buttons to help
you control media playback:
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At the bottom of this Mac Blu-ray Player software, from the left to the right, these buttons
respectively represent: Stop, Previous, Play/Pause (switchable), Next, Playback Speed, Playlist,
Audio, and Full Screen playback.

button: Click to stop playback and return to the main program interface.

: Click to play previous file/title, pause/resume playback, and next

file/title.

: Click to change the playback speed from 0.25X to 2X.

button: Click to open/hide the playlist panel.

button: Click to start/quit full-screen playback.

What’s more, you could right click the main interface for more options. You will then see a
right-click menu as below:



6

On the right-click menu, more options are available:

File: Click to Open File (shortcut: Command+O, to open one single file), Open Folder (shortcut:
Command+P, to open a folder), Open Iso File (shortcut: Command+I), Play/Eject disc, and open
Playlist.

Playback: multiple operations to control playback, like Play/Pause (Space), Stop (Command+S),
Next (Option+Down), Previous (Option+Up), Forward 30 sec (Right arrow), Backward 30 sec (Left
arrow), Rewind (Ctrl + Left), Fast Forward (Ctrl + Right), Speed, Volume Up (Up arrow), Volume
Down (Down arrow), and Mute (M).

Menu: Click to invoke the disc menu interface to let you choose which to play back.

Videos/Audios/Subtitles: These options enable you to adjust video settings, audio settings and
subtitle settings during playback.

Angles/Chapters: These options are for Blu-ray/DVD palyback only.

Also, the right-click menu includes some playback operations: Fullscreen playback (Command+F),
Always On Top (Command+T), Playlist (F3), Snapshot (Shift+S), and Player Settings (F5).

3. Introduce Leawo Free Blu-ray Player for Mac Program Menu

On the top-left corner of your computer, you could see the program menu of Leawo Free Blu-ray
Player for Mac. There are 6 tabs: Leawo Blu-ray Player, File, Playback, BD/DVD to MKV, Window
and Help.
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3.1 Leawo Blu-ray Player

Under the "Leawo Blu-ray Player" tab, you could view the program information by clicking the
"About Leawo Blu-ray Player", set program "Preferences"(detailed information will be
introduced below), ;set Services, Hid Leawo Blu-ray Player, Hide Others, Show All, and Quit
Leawo Blu-ray Player.

3.2 File

Under the "File" tab, you could choose to Open File, Open Folder, Open Iso File, Play Disc, Eject
Disc, and Playlist.
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3.3 Playback

Under the "Playback" tab, you could choose to Play or Stop playing, play previous movie or Next
movie on the playlist, Forward 30 sec, Backward 30 sec, Fast Forward or Rewind playback, Mute,
turn Volume Up or Down, and adjust Playback Settings (upon video, audio and subtitle).

3.4 BD/DVD to MKV

The “BD/DVD to MKV” tab is clickable only when the program has detected Blu-ray/DVD content
in playing. You could click this tab to choose to convert Blu-ray/DVD to MKV files without quality
loss.
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3.5 Window

Under the "Window" tab, you could determine the program playback mode, including: Fullscreen
playback, make Leawo Blu-ray Player Always on Top of other apps, call out the Playlist, take
Snapshot, and change Skin.

3.6 Help

The "Help" tab provides you solutions to get help from Leawo Software. You could visit the
online User Guide of Leawo Free Blu-ray Player for Mac, send Feedback and Bug Report to Leawo,
Check for Update, and Record sound and Convert media (these 2 requires other apps from
Leawo).



10

How to Purchase and Activate Leawo Blu-ray Player

Premium?

As mentioned above, Leawo Blu-ray Player is available in 2 versions: Free and Premium. The
Premium version helps convert Blu-ray/DVD to MKV without quality loss.

1. How to purchase Leawo Blu-ray Player Premium for Mac

There are multiple ways for you to purchase and upgrade to Leawo Blu-ray Player Premium for
Mac. You could directly visit the purchase page of Leawo Blu-ray Player Premium for Mac, or click
the “Get Pro” button on top-right corner of Leawo Free Blu-ray Player for Mac program interface
and then click the red “Purchase” button to purchase license code of Leawo Blu-ray Player
Premium for Mac. Once you have completed the purchase, the license code will be sent to you
via email.

2. How to activate Leawo Blu-ray Player Premium for Mac

Check your mail box to copy the license code you have purchased, then on Leawo Blu-ray Player
program, click the “Register” button to activate purchased license code.

https://www.leawo.org/blu-ray-player-mac/purchase.html?pdf
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Leawo Free Blu-ray Player for Mac
Preferences Settings

By right-clicking on the main interface and then going to the “Player Settings” option, or clicking
“Leawo Blu-ray Player > Preferences” on the top-left corner of the menu bar, you could enter the

program preferences settings panel. There are multiple program settings for better media
playback.

1. General settings

The "General" settings panel covers settings for Language, Convert and Snapshot. You could set
UI language, preferred audio language, preferred subtitle language, output video format, default
path for converting Blu-ray/DVD to MKV, snapshot format and path to save snapshot.

2. Video settings
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"Video" settings panel allows you to adjust playback, processing and teletext settings. You can
adjust display refresh rate, sync playback to display, display aspect, render method, hardware
acceleration, etc.

3. Audio settings
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You could set Audio output, Speaker Configuration, Boost volume level on downmix, Output
stereo to all speakers, Audio output device, Play GUI sounds, etc. on the "Audio" settings panel.

4. DVD/Blu-ray settings
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The "DVD Blu-ray" settings panel allows you to determine whether or not to Play DVD/Blu-ray
automatically, set Forced BD player region, and skip introduction before DVD/Blu-ray menu or
not.

5. Subtitles settings
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You could open the "Subtitles" settings panel to do subtitle related settings, including: Font, Size,
Style, Color, Character set, Override ASS/SSA subtitles fonts, Subtitle folder and Subtitle location,
etc.

6. Hotkeys settings
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On the "Hotkeys" settings panel, you could adjust hotkeys for various operations, like open file,
open folder, open ISO file, play/pause, play previous/next, etc.

7. File Associations settings
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You could select file extensions you want to associate with Leawo Blu-ray Player here on the “File
Associations” tab.
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How to Play Blu-ray/DVD/Video/Audio/ISO
Files with Leawo Free Blu-ray Player for Mac

As the best free Mac Blu-ray player software, Leawo Free Blu-ray Player for Mac offers you
totally free yet still extremely easy to use interface to play various media files on Mac. It could

not only play Blu-ray on Mac, but also DVD, HD video (up to 4K), audio, and ISO image file on
Mac. The below Blu-ray Player for Mac user guide would show you how to use Leawo Free

Blu-ray Player for Mac to play movies on Mac in detail.

Step 1: Load source media files

On the main interface of Leawo Free Blu-ray Player for Mac, you could see up to 2 optional boxes
(if you have both DVD drive and BD drive).

There are different cases according to your source media files:

1. If you want to play video, audio and ISO image file, there are 3 ways: a. click the "Open File"

button ; b. right click on the main interface and then select "File"

option to choose to open file, folder or ISO file; c. make use of the shortcut key(add one single
file: Command+O; add one file folder: Command+P).
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2. If you want to play Blu-ray/DVD disc, insert your disc into the disc drive and then the disc

name would appear on the main interface right below the “Play Disc” button .

Click the box with the disc name you've inserted.

After loading source media files, you could click the button to open the playlist panel and

see all loaded media files. On the playlist panel, you could click the to add,

remove or clear movies on playlist.

Step 2: Set subtitles (optional)

Leawo Free Blu-ray Player for Mac allows you to select subtitle from source media files, or even
add external subtitles to watch movies in familiar language. Right click on the interface and then
select "Subtitles..." option, or move mouse to the upper-left corner of the interface and then

click the subtitle icon to call out "Subtitles-Settings" panel.

You could click to Enable subtitles, set Subtitle offset, choose Subtitles from source media files if
available, and Browse for subtitles from local drive (this is not available for BD/DVD playback).
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Step 3: Video settings (optional)

Right click on the main interface during playing, or click the video setting icon on the

upper-left corner of the main interface to enter the "Video-Settings" panel.

On the "Video-Settings" panel, you could determine multiple settings upon video playback,
including: Deinterlace video, Deinterlace method, Video scaling method, Crop black bars, Video
mode, Brightness, Contrast, etc.

Step 4: Audio settings (optional)

On the upper-left corner, click the audio icon , or right click on the playback interface and

then choose "Audios…" option to enter the "Audio-Settings" panel.
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You could adjust audio Volume, Volume amplification, Audio offset, Audio stream, Audio output,
Audio output device and Set as default for all videos.

Note: If you’re playing Blu-ray/DVD content with disc menu, you could then click the menu

icon on the upper-left corner to directly reach the disc menu interface for determine which

content to play back.

Rip and Convert Blu-ray/DVD to MKV on
Mac without Quality Loss
If you have upgraded to Leawo Blu-ray Player Premium, you then could directly convert
Blu-ray/DVD file to MKV files without quality loss. How to convert DVD/Blu-ray to MKV files
within Leawo Blu-ray Player Premium? Check the below guide.

Step 1: Import Source Blu-ray/DVD files

Open Leawo Blu-ray Player for Mac and insert the Blu-ray or DVD disc into the drive that is
connected with your Mac computer. Then click on “BD/DVD to MKV” option on the program
menu bar to enter the Blu-ray to MKV conversion module and choose the disc for conversion.
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Step 2: Choose titles to convert

After entering the converter module, a converting message will pop up to let you choose titles
from source Blu-ray/DVD files for converting. After selecting titles, click the “OK” button to
continue.
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Step 3: Set converting directory

On the follow-up window, set output directory to save output MKV files in the “Output Folder”
box at the bottom left corner. After setting output directory, click the “Convert” button.
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Step 4: Start converting Blu-ray/DVD to MKV

When the converting starts, Leawo Blu-ray Player will start to convert Blu-ray/DVD files to MKV
files. If you are not a Premium user, there will pop up a window showing you the differences
between Free version and Premium version. You could purchase or register Leawo Blu-ray Player
Premium here.

Or, you could click the “Trial” button to start converting Blu-ray/DVD files with the Free version.
In such case, Leawo Blu-ray Player Free version will only convert the first 5-minute content from
source Blu-ray/DVD files. If you have already activated Leawo Blu-ray Player Premium, you will
directly see the converting window, showing you the detailed converting progress and other
necessary information.
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